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Just thought we’d give you a sneak peak: SumProduct is pleased to announce not one but TWO new books coming out very soon.  Books 4 and 5 in 
the Financial Modelling series will be out later in 2024 – more details to be announced very soon!!

We’re very excited about both of these books.  Indeed, the Dynamic Arrays edition is our longest book yet with over 600 pages of tips and tricks.

Brought Two Book

Want to join our book club? We have two books coming out soon and thought you might want to know!  
But that’s not all, as we provide our usual array of tips, tricks and other extravaganza, including reviewing how to sum a dynamic range.

All the regulars are here.  We have the usual Beat the Boredom Challenge, Charts & Dashboards tips, Excel for Mac, 
Visual Basics, Power Pivot Principles, Power Query Pointers, lots of Power BI Updates and Excel Updates too.  We 
even complete our A to Z of Keyboard Shortcuts this month and round off with more Excel functions where we finally 
get into the second half of the alphabet.  We’ve hit N!!

As always, happy reading and remember: stay safe, stay happy, stay healthy.

NEWSLETTER #138 - May 2024

Liam Bastick, Managing Director, SumProduct

www.sumproduct.com  |  www.sumproduct.com/thought

mailto:contact@sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com/thought


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

As many of our readers at this time of year prepare quarter-end reports, we thought we’d provide sum useful information.  We often want to 
sum data for a period of time, e.g. sales for the last quarter, year to date costs and rolling budgets / forecasts.  When we create these calculations 
“statically”, i.e. the range is specified explicitly.

For example, we might have something like the following example:

Here, we have created a static formula for the year-to-date sales using the calculation

=SUM(F4:J4)

Next month, we would have to update this to 

=SUM(F4:K4)

We can’t simply sum the range in case other users populate row 4 with forecast estimates, etc.  There is an alternative, and I thought I would go up 
to date and use Excel 365’s XLOOKUP function.

As a reminder, XLOOKUP has the following syntax:

XLOOKUP(lookup_value, lookup_vector, results_array, [if_not_found], [match_mode], [search_mode])

This function seeks out a lookup_value in the lookup_vector and returns the corresponding value in the results_array.  It may seem complex, but 
most of the time you will only require the first three arguments:

	 •	 lookup_value: this is required and defines what value you want to look up
	 •	 lookup_vector: this reference is required and is the row or column of data you are referencing to look up lookup_value
	 •	 results_array: this is where the corresponding item is you wish to return and is also required (even if it is the same as lookup_vector).  	
		  This does not have to be a vector (i.e. one row or one column of cells): it may be an array (with at least two rows and at least two columns 	
		  of cells).  The only stipulation is that the number of rows / columns must equal the number of rows / columns in the column / row vector 	
		  – but more on that later.
For the record, the remaining arguments are:

	 •	 if_not_found: this optional argument allows you to replace the usual return of #N/A with something more informative like an alternative 	
		  formula, text or a value
	 •	 match_mode: this argument is optional.  There are four choices:
			   ○	 0: exact match (default)
			   ○	 -1: exact match or else the largest value less than or equal to lookup_value
			   ○	 1: exact match or else smallest value greater than or equal to lookup_value
			   ○	 2: wildcard match.  You should use the special character ? to match any character and * to match any run of characters.
		  What’s impressive, though, is that for certain selections of the final argument (search_mode), you don’t need to put your data in 	
		  alphanumerical order!  As far as I am aware, this is a first for Excel

Summing a Dynamic Range
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	 •	 search_mode: this argument is also optional.  There are again four choices:
			   ○	 1: search first to last (default)
			   ○	 -1: search last to first
			   ○	 2: what is known as a binary search, first to last (requires lookup_vector to be sorted).  Just so you know, a binary search is a 	
	 	 	 	 search algorithm that finds the position of a target value within a sorted array.  A binary search compares the target value to the 	
	 	 	 	 middle element of the array.  If they are not equal, the half in which the target cannot lie is eliminated and the search continues 	
	 	 	 	 on the remaining half, again taking the middle element to compare to the target value, and repeating this until the target value 	
	 	 	 	 is found

o	 -2: another binary search, this time last to first (and again, this requires lookup_vector to be sorted).

Let’s have a look at XLOOKUP versus everyone’s favourite function (except me!), VLOOKUP:

You can clearly see the XLOOKUP function is shorter:

=XLOOKUP(H52,F41:F47,G41:G47)

Only the first three arguments are needed, whereas VLOOKUP requires both a fourth argument, and, for full flexibility, the COLUMNS function as 
well.  XLOOKUP will automatically update if rows / columns are inserted or deleted.  It’s just simpler.

We can use this to specify the start and end of our sum range as follows.  Consider the following example:

The formula is “simply”

=SUM(XLOOKUP(G18,H12:S12,H13:S13):XLOOKUP(G19,H12:S12,H13:S13))

This is just two XLOOKUP functions joined together within a SUM function, specifying the start and end of the range.  Indeed, if the First Date is 
after the Second Date it will still work.  The SUM function is not precious and will work in “reverse order” too.

The dates may be varied and the summation updates both automatically and correctly, viz.
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Simple!

For those who are getting upset at this point because they don’t have access to Excel 365 and / or the XLOOKUP function, do not despair.  The old 
faithful INDEX(MATCH) combo still works.  It’s just clunkier:

This month’s Final Friday Fix is about creating a universal option list for the whole workbook.  For this challenge, we want to create a dashboard to 
track the accommodation and catering services for one of our made-up clients: 

	 •	 a Dashboard worksheet shows which customer group is staying in which room and on what date
	 •	 a Catering sheet which displays the number of guests in each room and, by date, who will be using catering services (this is simply 	
		  generated by an INDEX MATCH formula from their data, or you could use an XLOOKUP formula instead). 

The client wants to be able to view by whole month, 14-day or 7-day in both reports at any time.  Similar to the screenshot below, we just need to 
input the ‘Start Date’, and click on the option to view as ‘7 days’, so that the list will be generated for the whole week to see which group of customers 
will be coming:

=SUM(INDEX(H13:S13,MATCH(G18,H12:S12,0)):INDEX(H13:S13,MATCH(G19,H12:S12,0)))

We hope you find it of sum use…

With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular Final 
Friday Fix challenges from yesteryear in this and upcoming newsletters.  
One suggested solution may be found later in this newsletter.  Here’s this 
month’s…

Beat the Boredom Challenge
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Whilst we are in the Catering sheet, the list is also updated accordingly, so that we may see how many we need to prepare catering for:

If we choose ’14 days’, the list becomes longer

with a corresponding effect in the Catering sheet:

Similarly, the list will be updated for the whole month if we choose to view ‘Whole Month’

This kind of viewing option list is like a filter, which may be applied to various problems when you work with Excel. 

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  
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If you use Excel for Mac, and you’ve been watching the gradual introduction of Power Query features over the last few years, you know that it doesn’t 
have all the capabilities that it has on Windows.  The Excel team has been adding more and more capability to Mac, but it’s still missing some key 
features.  One in particular is the ‘From Table/Range’ button:

Fortunately, this shouldn’t hold you back if you want to pull data from the current workbook into Power Query on Mac.  Just follow the simple steps 
below:

	 •	 Go to Data the Data tab of the Ribbon and press ‘Get Data’ (Power Query)

	 •	 In the window that opens, press the Blank Query button

With Steve Kraynak joining the team, we thought we would exploit his 
knowledge and recant all about Microsoft Excel for Mac.  Each month, 
we’ll cover a different topic to help you understand how Excel for Mac is 
different than Excel for Windows.  This month, we continue our discussion 

on Power Query.  Currently, Power Query on Mac does not have a button 
on the Data tab to let you start a query from a table or range in the 
current workbook.  No problem!  Keep reading to find out how to create 
such queries without the button.  

Excel for Mac
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	 •	 Where you see two [2] double quotes in the line that says Source = "", replace the "" with Excel.CurrentWorkbook() as shown in the 	
	 	 screen shot below:

	 •	 The code should be as follows (take care, it’s case-sensitive):

	
let

  Source = Excel.CurrentWorkbook()

in

  Source

TIP

Power Query is case-sensitive, so make sure you type Excel.CurrentWorkbook() exactly as shown above.   If you see an error like the 
following, it may be that you’ve typed it slightly differently [Ed. i.e. you typed it in wrongly!].  In the example below, there’s a lower-case W 
where it should be upper-case in “CurrentWorkbook”

	 •	 Press Next.  The Power Query Editor window will appear as shown below.  There will be two columns in the preview pane, Content and 	
	 	 Name.  The Content column will just say [Table], which means that each row represents a table or range of data coming from the 	
	 	 workbook.  The Name column shows the name of each table or range.  In this example, there’s a table called SalesDataTable and a range 	
	 	 called ProductsList 
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	 •	 To get the data from one of the tables or ranges, just press where it says “[Table]” in the row for the table or range you want to get data 	
	 	 from.  In the example shown here, clicking on [Table] in the row for the SalesDataTable adds steps to the query and shows the data that is 	
	 	 being imported from that table into the Power Query Editor.

Everybody has created quarterly reports, where we have to pump out the same charts again and again with different data.  Sometimes, you have all 
of the charts dynamically linked to your data, but every quarter you have to go through each one and rename them.  

Dynamic chart titles are the answer. 

To create a dynamic chart title, we first need a chart and some data:

Now you can use all the other features of Power Query to transform your data!

We’ll continue next month…

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we show you how 
to create dynamic chart titles. 

Charts and Dashboards
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To make the chart title dynamic we link it to a cell. Before we do that, we have to designate a cell to hold the chart title. 

The next step is to select the chart title and enter the cell reference into the formula bar, in this case it is:

='Dynamic Chart Title'!$G$18

Voila! We can change the title to anything we want and the chart will update automatically.

This may be time consuming at first, but you will soon speed up.  Until next month.
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We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month we look at declaring constants.

It is highly recommended any values that are passed into formulae, 
subroutines and / or functions are variables.  However, what if the value 
of that variable does not change?  There is a way to make it immutable by 
declaring it as a constant.  This means that it cannot be changed during 
execution.  By declaring constants, they can be easy to access without 

hardcoding the information more than once and make code much more 
readable and facilitate error checking.

Constants are declared in a similar way to Dim except using the keyword 
Const – except a constant should always be assigned a value when it is 
declared.

If somewhere in the code, it tries to reassign the value, the VBA Compiler spits an error message before execution.

The compiler determines what the data type is from the type of 
expression of the constant.  However, it is always good form to explicitly 
state a data type.  This is particularly important if you plan on doing 
arithmetic expressions in your code that results in what is known as a 

Long value and having an Integer constant will cause overflow errors.  
Using the As statement in a similar way to the Dim statement the data 
type of the constant may be cast.

Multiple constants can be declared on a single line as well:

Now knowing how constants are declared, like variables, the scope of the constants is also put under consideration.  This is declared the same way 
as variables – the subject of our past two articles.

More next time.

Visual Basics
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we discuss how to use an input Table to group text columns into new 
categories.

This month, we want to look up the following values: Glove, Shoe, Belt (say), in a column, but these values may change.  For this example, we are 
going to use the following text column:

What we want to do is create a column that will highlight if any one of 
the three values from the Lookup table are present in the Product Type 
column.  For example, if the Product Type value is “Leather Gloves”, we 
would want the column to recognise that that value had “Glove” in it.  
If the Product Type value is “Business Shoes”, then we would want the 
column to recognise “Shoe”, and so on.

We have already done something similar to this previously, one involving 
switching between numbers and text values here and another involving 
the SEARCH and SWITCH functions to look through text values here. 

They both involve creating a new column based on data in reference 
column.  However, the difference here is that those two previously 
outlined methods are not dynamic.  The end user would have to manually 
go into the formula for the calculated column and rewrite the formula, 
should the criteria change. 

This time, we will have the flexibility of redefining the lookup criteria 
with an external table.  To begin we will use the following lookup Table:

(OK, so we haven’t chosen “Belt” here, but you get the picture!)

The first DAX code we are going to write is: 

=SEARCH(
	 FIRSTNONBLANK(
		  'LookupTable'[Lookup],
		  1
		  ),
	 'Combined Example'[Product Type],
	 ,
	 9999
	 )

Power Pivot Principles

https://www.sumproduct.com/blog/article/power-pivot-principles/ppp-introducing-the-switch-function
https://www.sumproduct.com/blog/article/power-pivot-principles/ppp-grouping-text-columns-with-new-categories
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This DAX code uses the SEARCH and FIRSTNONBLANK functions.  We 
have used the value ‘9999’ as the value to return if not found as it is 
extremely unlikely that we would find a text value we are looking for 
in the 9,999th character position.  The column is only able to detect 

the first value in our lookup table ‘Gloves’, since we are using the 
FIRSTNONBLANK function.  We need the function to iterate for each 
value of the lookup table.

We are going to have to use the CONCATENATEX function to force the function to iterate for each row: 

=CONCATENATEX(
	 'LookupTable',
			   SEARCH(
				    FIRSTNONBLANK(
						      'LookupTable'[Lookup],
						      1
						      ),
				    'Combined Example'[Product Type],
				    ,
				    9999
				    ) 
	 )
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The CONCATENATEX function iterates the function to look for each value 
in the lookup table, Glove and Shoe. 

This method enables the column to highlight when a cell value contains 
both Glove or Shoe. This is highlighted on the 10th row, it finds ‘Glove’ 

at the first character position, hence 1, and it finds ‘Shoe’ on the 11th 
character position, hence 11, resulting in ‘111’. 

The final step is to use the IF function so that the function would return 
with the text value rather than the character position: 

The IF function checks if the number returned does not equal  9,999 and returns with the lookup table value.  Now we can add ‘Belt’ as criteria into 
the Lookup table and have the calculated column update automatically.

=CONCATENATEX(
	 'LookupTable',
	 	 IF(
	 	 	 SEARCH(
	 	 	 	 	 FIRSTNONBLANK(
	 	 	 	 	 	 	 'LookupTable'[Lookup],
	 	 	 	 	 	 	 1
	 	 	 	 	 	 	 ),
	 	 	 	 'Combined Example'[Product Type],
	 	 	 	 ,
	 	 	 	 9999
	 	 	 	 ) 
	 	 <> 9999,
	 	 'LookupTable'[Lookup],
	 	 ""
	 	 )
	 )
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Updating the Lookup table and refreshing the connection will yield:

With our new column we can set up slicers to dynamically segregate our data based on text inputs.  Let’s expand on the concept.

Imagine we have the following data table, noting that this screenshot is not exhaustive:
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We would like to be able to group the Product IDs by a new category.  These categories are detailed in the following table: 

In summary, if the Product ID text contains ‘Shoe’ the new column will display ‘Footwear’, and if the text contains ‘Jeans’ the new column will return 
with ‘Pants’, etc.

How do we do this?  Well, from our last blog, we used the following single column lookup table: 

This time we can alter our lookup table and have two columns, one column for the Lookup value and the other for the Category name we wish to 
return:
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After loading both tables into Power Pivot, we create a calculated column with the following code: 

=CONCATENATEX(
	 'LookupTable',
		  IF(
			   SEARCH(
					     FIRSTNONBLANK(
							       'LookupTable'[Lookup],
							       1
							       ),
				    'DataTable'[Product Type],
				    ,
				    9999
				    ) 
		  <> 9999,
		  'LookupTable'[Category],
		  ""
		  )
	 )

This code is very similar to the code we used last week, with one key difference.  Instead of returning with the 'LookupTable'[Lookup], we change it 
to 'LookupTable'[Category].  This way, the column will be populated with the new category that we wish to assign to each row:

We will also have to create a Sales column that multiplies the Price by the Quantity:

='DataTable'[Price]*'DataTable'[Quantity]
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We can now create the following PivotChart:

The next step is to create a Slicer for our new Category column:

We can now filter our graph to display different categories of our data.  The best part is that if we wish to change the categories or lookup values all 
we have to do is change the values in our lookup table, refresh the links in Power Pivot and our chart will update accordingly.

For example, updating our lookup table to: 
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and refreshing the links in Power Pivot, our PivotChart will be updated as follows: 

That’s it for this month; more next time.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we consider 
how to deal with import errors.

Imagine we have some employee data that we need to import and clean up.  To show the process, let’s upload it in its current error-ridden state:

Ignoring the problems for now, we choose to create a new query from the ‘Get and Transform’ section of the ‘Data’ tab, in this case using ‘From Table’:

Power Query Pointers

http://www.sumproduct.com/blog
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Since we are not going to go back and work out what caused these errors, we simply want to set them to zero [0]:

So, we’ve replaced the errors and we’re happy… well not quite.  If we look at the M code generated for this step, we see

Table.ReplaceErrorValues(#"Changed Type", {{"Feb-18", 0}, {"Average 2018", 0}})

Our column names are referenced.  We want it to be more robust than this – we wish to change all errors into zeroes.  Furthermore, we also want 
it to cope if the column names were to be changed.  Let’s replace the line of M code (above) with some different code.  To show what each step 
will do, we will create the first steps as custom columns, which we will remove at the end when we apply the code directly to the Advanced Editor.

Let’s begin by creating a new custom column from the ‘Add Column’ tab, that will contain all of our column headings.
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Now, we want to create a new custom column containing a pairing which says that each column is linked to a zero value.  We will use this later to 
make a substitution.

This gives us our substitution column.

Our final step is to apply the substitution.  We are not going to do this 
as a column, as we now want to create the solution as it would be 
more useful, and to do that we’re going to apply the steps directly to 

the Advanced Editor.  We’re removing any step that references column 
names (such as ‘Changed Type’), since we wish this query to apply to any 
similar data without worrying about column names.
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When we apply these changes, we get the transformed table, viz.

We should now be able to change the name of a column in the original source without affecting the query.

We’ve changed Feb-18 to Mar-18.  Now we will see what happens in the query…

The query is working independently of any column name changes.  Result!

Until next month.
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Unfortunately, the previous set of Power BI updates were announced after our newsletter went to print, so we’ve ended up with two months’ worth 
of updates for this newsletter!  There are new updates for Visual calculations, editing your data model in the Power BI Service, and deliver report 
subscriptions to OneDrive SharePoint amongst many others.

The full list of updates is as follows:

Visual calculations update in Preview

You can now add and edit visual calculations in the Service.  You may add a visual calculation by selecting ‘New calculation’ from the context menu 
on a visual after you publish a report to Power BI Service.

Reporting

	 •	 Visual calculations update in Preview
	 •	 On-Object Interaction updates 
	 •	 Mobile layout auto-create in Preview
	 •	 Expanding Spatial Data Integration: Shapefile Support in Azure 	
	 	 Maps Visual
	 •	 Data bars in Matrix subtotal / total conditional formatting
	 •	 Data labels alignment
	 •	 New visual: 100% Stacked Area chart 
	 •	 Line enhancements 
	 •	 Enhanced Q&A with Copilot-generated linguistic relationships

Modelling

	 •	 Write DAX queries in DAX query view with Copilot in Preview
	 •	 Enhanced Row Level Security editor is enabled by default in 	
	 	 Preview
	 •	 Selection expressions for calculation groups in Preview 
	 •	 DAX query view improvements in Preview  

Service

	 •	 Edit your data model in the Power BI Service – updates
	 •	 Undo / Redo, Clear all, and New filter cards in Explore 
	 •	 Deliver report subscriptions to OneDrive SharePoint in 	 	
	 •	 Preview
	 •	 Storytelling in PowerPoint: improved image mode in the	
	 	 Power BI add-in for PowerPoint
	 •	 Storytelling in PowerPoint: continuous slide show auto refresh
	 •	 Storytelling in PowerPoint: auto populating the slide title
	 •	 Introducing the Fabric metadata scanning sample application 
	 •	 Dynamic Subscriptions for Power BI and paginated reports

Mobile

	 •	 Custom visual SSO support
	 •	 Supporting Folders in workspace
	 	

	
	 •	 New ‘Clear barcode’ action in the report footer
	 •	 Open Power BI items in full screen mode

Developers

	 •	 New title flyout for Power BI Desktop developer mode
	 •	 Rename to ‘Semantic Model’ in Power BI Project files 
	 •	 System file updates for Git integration
	 •	 Hierarchical Identity filter API

Visualisations

	 •	 New visuals in AppSource
	 •	 Dumbbell Bar chart by Nova Silva
	 •	 Date Picker by Powerviz
	 •	 Drill Down Combo PRO
	 •	 PDF Uploader / Viewer
	 •	 Inforiver Premium Matrix
	 •	 Financial Reporting Matrix by Profitbase
	 •	 Horizon chart by Powerviz
	 •	 Drill Down Scatter PRO by ZoomCharts
	 •	 Image Gallery
	 •	 Horizontal Bar chart
	 •	 TrendsMulti-pane Card 1.1

Paginated Reports

	 •	 Connect to new data sources from Power BI Report Builder in 	
	 	 Preview

	 •	 Localised parameter prompts in Power BI Report Builder

Analytics

	 •	 Introducing Copilot pane in Power BI Desktop in Preview.

Let’s look at each in turn.

Power BI Updates
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Also, after you publish a report that has visual calculations in it, you can access the visual calculations edit mode by selecting a visual calculation and 
choosing ‘Edit calculation’.

To balance the needs of existing users who prefer to build visuals 
quickly in the pane, with the needs of new users that need guidance 
when picking a visual type or appropriate field wells, you no longer must 
choose one or the other path, both are now available.

This update streamlines the Build pane and moves the visual suggestions 
feature to be inside the on-object build button only.  Need help building 
your visual?  Use the on-object ‘suggest a visual’ experience, whereas if 
you already know your way around, use the Build pane as before.

The Gauge visual now supports the new on-object formatting sub selections.  Simply double click on your Gauge visual to enter Format mode, then 
right-click on which part of the visual you’d like to format using the mini-toolbar.

On-Object Interaction updates
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The pane switcher has been renamed to Pane manager and revised in this update.  Now, Microsoft has updated the order of the pane listings and 
added the settings that pertain to the Pane manager directly in this menu.
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Whilst you may realise that mobile optimised report layouts are the best 
way to view data in the Power BI mobile applications, you may be well 
aware that it requires extra work to create said layout.  As of this update, 
you can now generate a mobile-optimised layout with a click of a button.  
This long-awaited feature allows you to easily create mobile-optimised 
layouts for any new or existing report page, saving considerable time.

When you switch to the mobile layout view in Power BI Desktop, if the 
mobile canvas is empty, you can generate a mobile layout just by selecting 
the ‘Auto-create’ button.  The auto-create engine understands the 
desktop layout of your report and builds a mobile layout that considers 
the position, size, type and order of the visuals that the report contains.  

It places both visible and hidden visuals, so if you have bookmarks that 
change a visual’s visibility, they will work in the automatically created 
mobile layout as well.

You may edit the automatically created mobile layout, so if the result is 
not exactly what you expected, you can tweak it to make it perfect for 
your needs.  

To enable the new mobile layout auto-create capabilities, switch on the 
‘Auto-create mobile layout’ Preview feature in Power BI Desktop: File 
-> Options and settings -> Options -> Preview features -> Auto-create 
mobile layout.

After successfully integrating WKT and KML formats in February, 
Microsoft has extended their support further to include the Shapefile 
format.  With just two clicks, you may now overlay your spatial data onto 

Azure Maps’ base map.  Whether through file upload or a hosted file, 
Azure Maps’ reference layer enable easy incorporation of your data.

Mobile layout auto-create in Preview

Expanding Spatial Data Integration: Shapefile Support in Azure Maps Visual
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This Power BI release welcomes the upgrade of the data bars for Matrix and Table to apply them to values only, values and totals, or total only.  This 
enhancement provides better control and reduces unnecessary noise to keep your tabular visuals nice and clean.

You now possess the flexibility to apply data bars to the following options:

	 •	 Values Only: display data bars based solely on the values within your visual
	 •	 Values and Totals: extend data bars to include both individual values and their corresponding totals
	 •	 Total Only: show data bars exclusively for the overall total.

This enhancement provides better control over your tabular visuals, reducing unnecessary noise and ensuring cleaner presentation.

Significant improvements have now been made to the data labels in the Power BI charts.  Now, when you use a multi-line layout with title, value 
and detail labels, you have the flexibility to horizontally align them.  This means you can create cleaner, more organised visualisations by ensuring 
that your labels are neatly positioned.  To take advantage of this, follow these steps: 

	 1.	 navigate to the Data Labels section

	 2.	 click on Layout

	 3.	 explore the Horizontal alignment options for aligning your labels.

Data bars in Matrix subtotal / total conditional formatting

Data labels alignment
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There is a new 100% Stacked Area chart, now available in the core visuals 
gallery.  These visuals display the relative percentage of multiple data 
series in stacked areas, where the total always equals 100%.  It’s useful 

for showing the proportion of individual series to the whole and how 
they change over time.  You may locate it in the visual gallery, on-object 
dialog or Format pane, right next to the Stacked Area chart.

Line enhancements 

There are new line control features for Line charts.  You can:

	 •	 adjust line colour transparency under Lines -> Colors -> Transparency
	 •	 control the colour and transparency of each series by selecting them in the ‘Apply settings to’ dropdown

	 •	 use Monotone and the new Cardinal smooth type for full control of smooth lines

	 •	 choose from before, centre and after step lines to align your visual with your story.

Apparently, these new line enhancements are just the beginning – there is more to come.  I am trying not to get too excited.

New visual: 100% Stacked Area chart 
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Improving your linguistic schema is an important step in making sure 
that the Q&A visual can understand the wide range of questions people 
might ask about their data.  This is why, back in September, Microsoft 
added a new section into the Q&A setup menu to help you add linguistic 
relationships to teach Q&A about words which qualify or relate your data.  

Coming up with all the different words people might be using to refer to 
your data can take time and effort, and Power Bi has been working on 

ways to make that process easier.  In November, Microsoft created a 
method to quickly generate new synonyms for the names of tables and 
columns in your model; this update sees the same functionality generated 
for linguistic relationships.

When you open a report with a Q&A visual, if you have Copilot enabled 
and you’ve already added synonyms, you’ll now see a banner prompting 
you to get relationships with Copilot as well:

Unlike with synonyms, Copilot-generated relationships will not be used 
to understand natural language inputs until you have approved them, so 
do make sure you accept the ones which work for your model.

You can also now use Copilot to improve the Q&A engine’s term 
recognition when you ask questions.  This new feature will trigger when 

you ask Q&A a question which uses words or phrases which Q&A doesn’t 
recognise, but which it detects might be referring to data entities like 
tables or columns.  Then, Copilot will also check those unknown words or 
phrases to see if there is any reasonable match.  If so, Copilot will return 
the answer as a visual as though a suggested synonym had been applied.

This feature is not a replacement for synonyms.  In fact, adding synonyms 
for the entities in your semantic model is even more important to create 
good matches, as they increase the surface area to check for similarities.  
It will widen the range of inputs Q&A will recognise, but like a multiplier, 
it will improve recognition for well-modelled data much better than it 
will for poorly modelled data.  

This feature will be automatically enabled when you choose to get 
synonyms with Copilot, but you can also turn it on or off manually in the 
suggestion settings menu in the Synonyms tab in Q&A setup.

Enhanced Q&A with Copilot-generated linguistic relationships
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The DAX query view with Copilot is now available in public Preview.  You 
may enable this feature in the Preview section of File -> Options and 
settings -> Options, click on ‘DAX query view’ and launch the in-line 
Copilot by clicking the Copilot button in the Ribbon or using the shortcut 
CTRL + I.

With Fabric Copilot, you can generate DAX queries from natural 
language, get explanations of DAX queries and functions, and even get 
help on specific DAX topics. 

Write DAX queries in DAX query view with Copilot in Preview
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The enhanced Row Level Security editor is now the default experience 
in Power BI Desktop.  With this editor, you can quickly and easily define 
Row Level Security (RLS) roles and filters without having to write any 
DAX.  Simply choose ‘Manage roles’ from the Ribbon to access the 

default drop-down interface for creating and editing security roles.  If 
you prefer using DAX or need it for your filter definitions, you can switch 
between the default drop-down editor and a DAX editor.

Calculation groups have become more powerful.  With this update, 
Microsoft has introduced the Preview of selection expressions for 
calculation groups, which allow you to influence what happens in case 
the user makes multiple selections for a single calculation group or 
does not make a selection at all.  This provides not only a better way to 
perform error handling, it also opens interesting scenarios that provide 
some good default behaviours, e.g. automatic currency conversion.  
Selection expressions are optionally defined on a calculation group and 
consist of an expression and an optional dynamic format expression.

This new capability comes with an extra benefit of potential performance 
improvements when evaluating complex calculation group items.

To define and manage selection expressions for calculation groups, you 
can leverage the same tools you use today to work with calculation 
groups.  On a calculation group you will be able to specify the following 
selection expressions both consisting of the Expression itself and a 

FormatStringDefinition:

	 •	 multipleOrEmptySelectionExpression: this expression has a 	
		  default value of SELECTEDMEASURE() and will be returned 		
		  if the user selects multiple calculation items on the same 		
		  calculation group or if a conflict between the user’s selections 	
		  and the filter context occurs

	 •	 noSelectionExpression: this expression has a default value of 	
		  SELECTEDMEASURE() and will be returned if the user did not 	
		  select any items on the calculation group.

Here’s an overview of the type of selection compared to the current 
behaviour that was shipped before this Preview, and the new behaviour 
both when the expression is defined on the calculation group and when 
it’s not.  The items in bold are where the new action differs from the 
previous approach.

Enhanced Row Level Security editor is enabled by default in Preview

Selection expressions for calculation groups in Preview 
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Type of selection Current behaviour New behaviour 
without a defined 
selection expression

New behaviour with a selection expression 
defined

Single selection Calculation group 
selection is applied

N/A; no change to 
behaviour N/A; no change to behaviour

Multiple selection Calculation group is 
not filtered

Calculation group is 
not filtered

Calculation group evaluates specified  
multipleOrEmptySelectionExpression

Empty selection Error Calculation group is 
not filtered

Calculation group evaluates specified  
multipleOrEmptySelectionExpression

No selection Calculation group is 
not filtered

Calculation group is 
not filtered

Calculation group evaluates specified  
multipleOrEmptySelectionExpression

To illustrate, here are some examples.

EVALUATE

{

CALCULATE (

[MyMeasure],

'MyCalcGroup'[Name] = "item1" || 'MyCalcGroup'[Name] = "item2"

)

}

-- multipleOrEmptySelectionExpression on MyCalcGroup:

IF(ISFILTERED ( 'MyCalcGroup' ),\"Filters: \"& CONCATENATEX (FILTERS ( 'MyCalcGroup'[MyCalcGroup] 
),'MyCalcGroup'[MyCalcGroup],\", \"))

IF (

ISFILTERED ( 'MyCalcGroup' ),

"Filters: "

& CONCATENATEX (

FILTERS ( 'MyCalcGroup'[Name] ),

'MyCalcGroup'[Name],

", "

)

)

-- Returns “Filters: item1, item2”

If the user makes multiple selections on the same calculation group, the 
current behaviour is to return the same result as if the user did not make 
any selections.  In this Preview, you can specify a multipleOrEmptySelect

ionExpression on the calculation group.  If you did, then we evaluate that 
expression and related dynamic format string and return its result.  You 
can for example use this to inform the user about what is being filtered:

MULTIPLE OR EMPTY SELECTIONS
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In case of a conflict or empty selection on a calculation group, you might have seen this error before:

With this new behaviour, this error is consigned to history and will evaluate the multipleOrEmptySelectionExpression if present on the calculation 
group.  If that expression is not defined, Power BI will not filter the calculation group.

Current

Note how both the currency to convert to as well as the “conversion” calculation group item is selected.

One of the best showcases for this scenario is automatic currency 
conversion.  Today, if you use calculation groups to do currency 
conversion, the report author and user must remember to select the 
right calculation group item for the currency conversion to happen.  
With this Preview, you are now empowered to do automatic currency 

conversion using a default currency.  On top of that, if the user wants to 
convert to another currency altogether, they can still do that, but even 
if they deselect all currencies the default currency conversion will still 
be applied.

NO SELECTIONS
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New

Notice how the user must only select the currency to convert to.

Microsoft released the public Preview of DAX query view in November 2023.  With this set of updates, this has been improved as follows:

	 •	 re-ordering of query tabs is now available

	 •	 the ‘share feedback’ link has been added to the command bar

	 •	 coach marks for DAX query view.

More INFO DAX functions have been added too:

	 •	 INFO.STORAGETABLECOLUMNS(), which is equivalent to DISCOVER_STORAGE_TABLE_COLUMNS
	 •	 INFO.STORAGETABLECOLUMNSEGMENTS(), which is equivalent to DISCOVER_STORAGE_TABLE_COLUMN_SEGMENTS
	 •	 INFO.STORAGETABLES(), which is equivalent to DISCOVER_STORAGE_TABLES.

Edit your data model in the Power BI Service – updates

Below are the improvements made to the data model editing in the Service Preview.

AUTODETECT RELATIONSHIPS

Creating relationships for your semantic model on the web is now easier using autodetect relationships.  Simply go to the Home tab on the Ribbon 
and select the ‘Manage relationships’ dialog.  Then, choose ‘Autodetect’ and let Power BI find and create relationships for you.

DAX query view improvements in Preview
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SORT BY COLUMN

Within the web, you can now edit the sort by property for a column in your semantic model.

Undo / Redo, Clear all, and New filter cards in Explore 

This update adds a few new features to the new Explore experience.

UNDO / REDO

Now it’s simple to undo your previous action or use the ‘Reset all changes’ to go back to the last save state of your exploration.  Do note though that 
if you haven’t saved your exploration yet, then reset will clear your canvas back to blank.  Be careful!

ROW LEVEL SECURITY

Microsoft has made several improvements to the Row Level Security (RLS) editor in the web.  In the DAX editor you can now perform the following 
actions:

	 •	 use IntelliSense to assist in defining your DAX expression
	 •	 verify the validity of your DAX expression by clicking the check button
	 •	 revert changes to your DAX expression by selecting the X button.



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

CLEAR ALL

The new ‘clear all’ feature allows you to wipe your canvas back to blank.  This works great when using Explore as a whiteboarding space.  This is made 
simple with the new ‘clear all’ option.

NEW FILTER CARD STYLING

When using the filtering experience in Explore you’ll now notice an update to the Filter cards style and readability. 

Deliver report subscriptions to OneDrive SharePoint in Preview

You can now send subscriptions to OneDrive SharePoint (ODSP).  With this update, all your large reports, both PBIX and paginated reports can be 
sent to ODSP.  At this time, the workspace must be backed by a premium capacity or equivalent Fabric capacity.
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Power BI currently supports “Standard” subscriptions.

You need to select the ‘Attach full report’ option.

This update supports more output formats for paginated reports.
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Once you select the output format, you can select the OneDrive or SharePoint option, the location and enter the subscription schedule to have your 
report delivered.

This feature will not be supported in Sov clouds whilst in Preview.

Microsoft has made saving Power BI content as an image simpler and 
more powerful.

First, Power BI has added a new dropdown menu to the add-in’s footer.  
In that menu, you may choose whether you want to see live data or a 
snapshot.  Thus, it is now much easier to find where to switch between 
live data and a static image.

Second, for snapshots, you now have two options:

	 1.	 Public snapshot: anyone who can view the presentation can 	
		  view the image

	 2.	 Snapshot: only those who have permission to view the report 	
		  in Power BI will be able to see the snapshot.

Third, Power BI has disabled the default snapshot, so that the slide 
thumbnail doesn’t show the image by default (this also applies when 
you copy and paste the slide into an email for example), but only after 
the add-in is loaded and the required permissions have been checked.

Lastly, this setting is also honoured when you open the presentation 
in PowerPoint for the web.  You still cannot change a live view into a 
snapshot in PowerPoint for the web, but if you or someone else has 
changed the view to snapshot in the PowerPoint desktop application, 
this will be respected, and you will see the snapshot also in PowerPoint 
for the web.

PowerPoint allows you to continuously playback a presentation.  This is 
especially useful when you want to present information in public displays 
without any human interaction.

If a presentation that is running continuously has slides that include the 
Power BI add-in, the data in the add-in might become outdated, since 
the add-in gets the data from Power BI when the slide is loaded or when 

the user manually refreshes the data being presented.

With the new automatic refresh in slide show feature, you can set 
the add-in to automatically pull fresh data from Power BI while the 
presentation is in slide show mode, ensuring that the presentation will 
always show the most recent data.

Storytelling in PowerPoint: improved image mode in the Power BI add-in for PowerPoint

Storytelling in PowerPoint: continuous slide show auto refresh
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To enable automatic refresh, go to the add-in footer, select Add-in options, choose ‘Slide show settings’, check ‘Automatic refresh in slide show’ and 
set the desired frequency.

It should be noted that auto refresh only happens in slide show mode and not while you’re editing the presentation.

When you add the Power BI add-in to an empty slide that doesn’t have a 
title yet, the Power BI add-in is there to assist.  It offers you suggestions 
for the slide title based upon the content of you add-in.  The title can be 

the report name, the page / visual name, or both.  Just select the desired 
option and hit ‘Add title’.

The new Fabric metadata scanning application is now available.   
This sample application builds upon the metadata scanning capabilities 
of Fabric’s set of Admin REST APIs collectively known as the scanner APIs.  
This new app can be used as a reference for administrators interested in 
utilising the Scanner API to catalogue and report on all the metadata of 
their organisation’s Fabric items.

The Fabric metadata scanning sample app handles all the steps for 
calling the scanner API including authentication, parallelism, throttling 

and incremental scanning.  In addition, it provides a central configuration 
file which can be easily modified to suit the specific needs of the caller.  
Currently, authentication is supported both by using a service principal 
and a delegated token.

The app is available as a Microsoft open-source project, and therefore 
the company is open for suggestions and improvements to this new 
feature.

It has also been announced that you may now send dynamic per 
recipient subscriptions to up to 1,000 recipients instead of the earlier 
limit of 50 recipients from the data in the Power BI semantic model.  For 
existing subscriptions, Power BI will automatically send subscriptions up 

to 1,000 recipients if your Power BI semantic model contains that many 
rows of data.  You need to edit the subscription if you don’t want to 
automatically send subscriptions. 

Storytelling in PowerPoint: auto populating the slide title

Introducing the Fabric metadata scanning sample application 

Dynamic Subscriptions for Power BI and paginated reports
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This feature will be available in some regions immediately.  However, depending upon the geography in which your Power BI tenant is located, it 
may take up to two weeks to appear.

Custom visual SSO support

Custom visuals that use the new authentication API are also supported when viewed in the Power BI Mobile applications.  No additional authentication 
is required, making sure that the data exploration experience has no interruptions.

Supporting Folders in workspace

The Power BI Mobile applications support folders in the workspace.  Therefore, you may access items that are arranged in folders inside your 
workspace directly from the mobile app.
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Workspace and folders are Fabric entities, which means that you can 
add items that are not necessarily Power BI items to a workspace.  
However, the Power BI Mobile apps only support a subset of Power BI 

items.  Therefore, only the Power BI item will be accessible when you are 
browsing the folder content from the app.  If a folder contains only non-
Power BI items, it will appear empty in the mobile application.

When a field in your model is marked as a barcode, you can use your 
mobile device camera to scan the barcodes of real objects to filter 
reports that are built on this model.  This feature is extremely useful 
for retail, where you can scan the barcode on a piece of merchandise 
to get a report showing data about the item directly in your mobile app  

(for example, inventory information, product selling data).

To make it easier and more intuitive to use barcodes, Power BI has added 
a new button to the report footer that makes it a one-click action to clear 
any previously scanned barcode from the report’s filter.

The aim of the Power BI Mobile apps is to always always keep in mind the 
frontline workers who need quick access to their content.  In this update, 
it has been made possible to open Power BI items on full screen, so that 
users may view their data more easily.

Opening an item on full screen is supported both for launch items and 
when using a universal link.

A launch item is a Power BI item (report, page, app, etc.) that the user has 
selected to automatically open when they open the app.  Now, you may 
also tell the Power BI Mobile app to open this item in full screen mode.

To set a launch item to open in full screen mode, go to Settings -> Launch 
item and enable the ‘Open in full screen’ toggle.

Using an MDM tool that supports an AppConfig file, mobile device 
administrators can also configure a launch item to be opened in full screen 
mode for their users.  

You can also add the query parameter? fullscreen=1 to a Power BI item’s 
link.  When you use a link with this parameter on your mobile device, the 
mobile app will open the item in full screen mode.

New ‘Clear barcode’ action in the report footer

Open Power BI items in full screen mode
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New title flyout for Power BI Desktop developer mode

You can quickly recognise when you are working on a Power BI Project (PBIP) by looking at the Title bar:

If you click on the Title bar, you will see a new flyout that is specific for Power BI Project.  This lets you easily locate the Power BI Project files as well 
as the display name settings for the report and the semantic model.  You can also open the folder in File Explorer by clicking on the paths.
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Following the rename to ‘Semantic Model’ announced last November, Power BI Project files (PBIP) also adhere to that naming change.  Now, when 
saving as a PBIP, the following changes will be verified:

	 •	 Semantic Model folder, “\*. Dataset\”, will be saved as “\*.SemanticModel\”.  This is only applied to new PBIP files; existing will keep the 	
		  current folder name

	 •	 “definition.pbidataset” file is renamed to “definition.pbism”.

Currently, when synchronising Fabric items with Git, every item directory is equipped with two [2] automatically generated system files, item.
metadata.json and item.config.json.  These files are vital for establishing and maintaining the connection between the two platforms.

Rename to ‘Semantic Model’ in Power BI Project files 

System file updates for Git integration

As part of efforts to simplify the integration with Git, Power BI has consolidated these files into a single system file: . platform.  This new system file 
will encompass all the attributes that were previously distributed between the two files.

When you make new changes to Git, your system files will be updated 
automatically to the new version in conjunction with your modifications.  
Both your own changes and the new file updates will show as part of the 

commit operation.  Additionally, any new projects exported from Power 
BI desktop via developer mode will adopt the new system file format.  
Beyond these adjustments, there will be no impact on your Git workflow.



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Hierarchical Identity filter API

API 5.9.0 introduces a new filter API.  This API allows you to create a visual that can filter matrix data hierarchically based on data points.  This is useful 
for custom visuals that leverage group-on keys and allow hierarchical filtering using identities.

Dumbbell Bar chart by Nova Silva

In the latest release, the capability to display multiple dumbbell bars in a single row has been introduced, allowing for the presentation of more than 
two values.  This update opens new possibilities, including the creation of the Adverse Event Timeline plot, or AE Timeline.

The AE Timeline serves as a graphical representation of the timing of 
adverse events in clinical trials or studies.  Its primary objective is to 
visually convey when adverse events occur concerning the timing of 
treatment or exposure.  Widely used in medical research, especially 

during safety data analysis in drug development, the AE Timeline is now 
available within Power BI.

You may download it from AppSource.

New visuals in AppSource

Latest visuals include:

	 •	 CloudScope Image

	 •	 Donut Chart image

	 •	 neas-spc

	 •	 orcaviz-enterprise

	 •	 Stacked Insights

	 •	 Untap Text Box

	 •	 Waterfall – What’s driving my variation?

	 •	 Waterfall-Visual-Extended.
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Date Picker by Powerviz

The Date Picker visual offers a modern calendar view, Presets, Pop-up mode, Default Selection, Themes, and more.  The ‘First Day of Week’ option 
was added in the recent version update.

Key features include:

	 •	 Display Mode: choose between Pop-up and Canvas modes

	 •	 Presets: many commonly used presets like Today, Last Week, YTD, MTD or create your preset using field

	 •	 Default Selection: control the date period selected when the user refreshes or reopens the report
	 •	 Filter Type: choose between Range and Start / End types
	 •	 Month Style: select single- or double-month date slicer

	 •	 Multiple Date Ranges: flexibility to select multiple date ranges

	 •	 Themes: 15+ pre-built themes with full customisation

	 •	 Holidays and Weekends: customise holidays / weekends representation

	 •	 Import / Export JSON: build templates and share your designs.

You can try Date Picker for free from AppSource.
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Drill Down Combo PRO

Drill Down Combo PRO lets report creators build impressive charts of categorical data.  You may choose from multiple chart types and create Column, 
Line, Area and their combination charts.  You can use various customisation options to modify your chart whilst enhancing the readability of your 
data with features like conditional formatting and dynamic thresholds.

Main features include:

	 •	 conditional formatting: compare results against forecasts by automatically adjusting formatting based on a numerical value

	 •	 full customisation: customise x and y axes, the legend, outline and fill settings

	 •	 choose normal, 100% proportional, or zero-based stacking

	 •	 set up to four [4] static and / or dynamic thresholds to demonstrate targets

	 •	 customise multiple series simultaneously with series and value label defaults.

Popular use cases include:

	 •	 Sales and marketing: sales strategies, results, marketing metrics

	 •	 Human resources: hiring, overtime and efficiency ratios by department

	 •	 Accounting and finance: financial performance by region, office or business line

	 •	 Manufacturing: production and quality metrics.
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PDF Uploader / Viewer

You may now upload and securely share any PDF file with your colleagues.

This visual boasts several impressive capabilities:

	 •	 Microsoft certification ensures that the visual does not interact with external services, guaranteeing that your PDF files are securely 	
		  stored and encrypted within the report, in alignment with your report sensitivity settings

	 •	 it automatically saves your preferences, allowing you to navigate pages, adjust the zoom level, and scroll to emphasize specific sections.  	
		  Your colleagues will view the exact portion of the PDF you highlighted

	 •	 you have the flexibility to add text or draw lines to underline key content
	 •	 users can conveniently download the PDF file directly from the visual.

Inforiver Premium Matrix by Lumel delivers reporting capabilities for 
financial, paginated, IBCS, variance, management reporting and executive 
scorecards with the flexibility and familiar user experience of Excel.

With the recently released dynamic drill SDK / API, this now offers the 
Performance Mode, so you don’t have to compromise between the 
initial load performance offered by the native matrix and the alternative 
capabilities offered by Inforiver.  You can now load the first two levels as 
the default dimensions of the hierarchy and then drill down to the lower 
levels as needed on demand, giving you the best of both worlds.

In addition to manual data input and what-if simulation capabilities, 
Inforiver’ s planning and forecasting capabilities are updated with the 
upcoming 2.8 release.  This includes a dedicated forecast toolbar, support 
for automatic rolling forecasts, dynamic handling of time series extensions 
and an option to distribute deficits to other time periods.

Furthermore, Inforiver notes and annotations are now context-aware and 
are dynamically updated based on the filter / slicer selection.

Inforiver Premium Matrix
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Financial Reporting Matrix by Profitbase

In this visual, users are now able to specify which rows should be classified as cost-rows, which will make it easier to get the conditional formatting 
of variances correctly:

Selecting a row, and ticking ‘is cost’ will tag the row as cost.  This can be used in conditional formatting to make sure that positive variances on 
expenses are a bad for the result, while a positive variance on an income row is good for the result.

The new version also includes more flexibility in measuring placement and column subtotals.

Measures can be placed:

	 •	 default (below column headers)

	 •	 above column headers

	 •	 in rows.

If you have multiple fields showing on your column headers, you can now decide which of these fields you want a column subtotal for.  This is in 
addition to the already existing features of the Financial Reporting Matrix:

	 •	 adding custom rows

	 •	 applying company / customer specific themes

	 •	 expand / collapse columns

	 •	 conditionally hide columns and more.

Highlighted new features include:

	 •	 new Format pane design

	 •	 measure placement – in rows

	 •	 select column subtotals

	 •	 row options.

You can get the visual from AppSource.
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Horizon chart by Powerviz

An Horizon chart is an advanced visual, for time-series data, revealing trends and anomalies.  It displays stacked data layers, allowing users to 
compare multiple categories while maintaining data clarity.  Horizon charts are particularly useful to monitor and analyse complex data over time, 
making this a useful visual for data analysis and decision-making.

Key features include:

	 •	 Horizon styles: choose Natural, Linear or Step with adjustable scaling
	 •	 Layer: layer data by range or custom criteria; display positive and negative values together or separately on top

	 •	 Reference line: highlight patterns with x-axis lines and labels
	 •	 Colours: apply 30+ color palettes and use FX rules for dynamic colouring

	 •	 Ranking: filter Top / Bottom N values, with ‘Others’
	 •	 Gridline: add gridlines to the x and y axes
	 •	 Custom ToolTip: add highest, lowest, mean and median points without additional DAX
	 •	 Themes: save designs and share seamlessly with JSON files.

Other features included are ranking, annotation, grid view, show condition and accessibility support.

Business use cases include time series data comparison, environmental monitoring and anomaly detection.  You can try Horizon chart for free from 
AppSource.
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Drill Down Scatter PRO by ZoomCharts

ZoomCharts has just launched the latest addition to their suite of custom visuals – Drill Down Scatter PRO.  It provides all the features you would 
expect from a Scatter chart visual, with the ability to drill down.  Simply click on a data point and see all the values underneath it.

This way, you can quickly find your answers while also gaining a full understanding of where they come from.  Furthermore, the visual’s user interface 
(UI) is designed to be smooth and user-friendly for PCs and touch devices with cross-chart filtering.

Main features:

	 •	 Drill down: create a multi-level hierarchy and drill down with just a click

	 •	 Dynamic formatting: apply custom marker colours, shapes or images to each data point directly from data

	 •	 Trendlines: show a linear or polynomial regression line on the chart

	 •	 Thresholds: display up to four [4] line or area thresholds on each axis
	 •	 Area shading: highlight up to eight [8] custom areas with rectangles or ellipses.
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Image Gallery

The Image Gallery is the first visual to be certified by Microsoft that allows for the display of high-quality images and their exportation along with 
other report content.  There is no need to upload images to the Cloud, a CDN or use any datasets.  Simply import your images directly into the visual 
and share them instantly with your colleagues.

It should be noted that:

	 •	 Microsoft certification ensures that the visual doesn’t interact with external services, ensuring that your images are securely stored and 	
		  encrypted within the report, consistent with your report’s sensitivity settings

	 •	 it automatically saves your selected image in preview mode, allowing your colleagues to view the exact image you have highlighted

	 •	 images may be uploaded or removed exclusively in Edit mode.  Users in View mode can only view the images

	 •	 the visual is compatible with Power BI’s export functionality to PDF and PowerPoint.

Horizontal Bar chart

This is a space-saving Horizontal bar chart designed with category labels placed inside the bars for clarity.  This chart serves as an efficient filter to 
navigate through your data more effectively, optimising space by placing the category labels within the bars themselves.

It should be noted that:

Microsoft certification ensures that the visual doesn’t interact with external services, ensuring that your images are securely stored and encrypted 
within the report, consistent with your report’s sensitivity settings

	 •	 adjustable bar thickness and spacing: offers the flexibility to adjust the thickness of the bars and the spacing between them.  This allows 	
		  for optimal use of space and improves readability, especially when dealing with large datasets

	 •	 ToolTip details on hover: displays detailed information about each category when the user hovers over a bar.  This feature provides 	
		  additional context and insights without cluttering the visual

	 •	 data-driven category labels: automatically updates category labels based upon the data source.  This ensures that the chart remains 	
		  accurate and up to date, reflecting any changes in the underlying data

	 •	 support for hierarchical data: allows users to drill down into hierarchical categories within the chart.  This functionality enables a more 	
		  detailed data analysis without leaving the context of the initial visual

	 •	 export options: offers the ability to export the chart as an image or PDF, facilitating easy sharing and reporting outside of Power BI.
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Trends

There is now a Trends visual for Power BI, leveraging Google Trends data for strategic business analysis.  This visual tool allows you to compare brand 
popularity, monitor market trends and gain insights into consumer search behaviours directly within your Power BI environment.

With Trends visual, you can:

	 •	 analyse the ebb and flow of brand interest over time to identify market opportunities and competitive threats

	 •	 compare the popularity of products to inform marketing strategies and product development decisions

	 •	 understand seasonal trends to optimise your marketing campaigns and inventory planning.

Securely integrated and easy to use, Trends displays your Power BI reports as a dynamic analysis tool, offering a projected view of the market 
landscape. 

Multi-pane Card 1.1

The new Multi-pane Card visual may be used to group and show data in multiple collapsible panes in Power BI reports.  It is an alternative to multi-
row card visual, but it can combine columns into a few groups and put each group’s data in each pane.  It is suitable to show data in detail with a 
reduced number of report pages.
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Data can be sorted by a specified column and numbers can be converted to a human readable string.  You can also set up how many rows that you 
want to show on the card.  Using these features, it will be very easy to show “Top 10 best performing stores” or “Top 10 worst performing stores” 
for retail businesses.

Connect to new data sources from Power BI Report Builder in Preview

You can now connect to new data sources such as Snowflake and Databricks using the ‘Get Data’ button in the Power BI Report Builder.
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Follow the simple, click-through experience of Power Query online.  Select the data source that you want to connect to.

If you want to use AAD, you need to create a shareable cloud connection.  You can create one or use one that has been shared with you.
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You might also select the shareable cloud connection from the ‘Connection’ dropdown.  Make sure that the report consumer has permissions to 
the shareable cloud connection.

Once you have a connection, select Next.

You can transform the data that was selected.

In the Power Query editor, you can perform all the operations supported.
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The M query will be used to build your RDL dataset.

You can use this dataset to build your paginated report.  You can publish the report to the Service and share it.

Localised parameter prompts in Power BI Report Builder

You no longer need to create several reports to support parameter prompts in more than one language.  You may simply set an expression for the 
prompt in Power BI Report Builder and specify the translated labels for a given language that the prompt should be displayed in. 
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Introducing Copilot pane in Power BI Desktop in Preview

Earlier this year, Microsoft announced the Preview of Copilot for all customers with Premium / Fabric capacity in Power BI web.  This update sees the 
same Copilot experience for report creation is now available for Preview in Power BI Desktop.  With this current Preview, users may create reports 
faster and easier in the Power BI Desktop experience.  You can now open the Copilot pane in report view and ask Copilot to:

	 •	 Create a report page: Copilot will create an entire report page for you by identifying the tables, fields, measures and charts that would 	
		  help you get started
	 •	 Summarise a semantic model: Copilot will help you understand your Power BI semantic model by summarising the data in your model
	 •	 Suggest a topic: Copilot will suggest topics for your report pages.

More next month.

This month sees Export to CSV and Show Details in PivotTables are now available in Excel for the web.  Also, creating Power BI-connected tables is 
available in Excel for Windows users, together Office Scripts for Office 365 E1 and F3 licenses.

In summary:

Excel for the web

	 •	 Export to CSV

	 •	 Create Power BI Connected Tables in Excel

	 •	 Show Details in PivotTables

Excel for Windows

	 •	 Office Scripts for Office 365 E1 and F3 Licences.

Let’s get started.

Export to CSV

The ability to export to CSV is now available to all web users.  This experience was already supported for Windows and Mac users.  Now this feature 
is available to Excel for the web users too.  You may take advantage of this lightweight file format in Excel for the web to exchange and use data 
between applications and across platforms.

It works as follows:

	 •	 Create or open an existing worksheet in Excel for the web

	 •	 Select File -> Export -> Download this sheet as CSV (.csv). 

New Features for Excel
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The downloaded .csv file is then available in your local folder and ready to use.

Create Power BI Connected Tables in Excel

Yes, we know we mentioned this last month, but for completeness, we reiterate it here.  Back in August last year, Microsoft announced new ways to 
create connected tables in Excel with Power BI.  Now, this feature is available to all in Excel online.

It goes further: Microsoft has also been working hard to ensure that all Microsoft 365 update channels are able to use this feature in the Excel 
desktop application.

To connect directly to data in your semantic model:

	 •	 Select ‘Data from Power BI’ on the Data tab of the Ribbon

	 •	 Use the search feature in the ‘Power BI Datasets’ pane to find the dataset / semantic model you’d like to connect to and select ‘Insert Table’
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•	 Use the ‘Create Table’ dialog to:

		  ○	 select data to appear in your Table in the Data pane

		  ○	 apply any filters you’d like in the Filters pane

		  ○	 rearrange the field order in the Build pane

	 •	 Select ‘Insert Table’.  You now have a Table connected directly to your Power BI semantic model.  Just like with other Connected Table 	
		  experiences, the workbook contains a connection that you can review and modify in the Queries and Connections properties.

There are some limitations and other points to consider:

	 •	 After you select From Power BI in the Excel Ribbon, the artifacts loaded in the pane are not all the semantic models you have access to.  	
		  They are a selection of your most used semantic models.  You should use the search bar in the pane to get additional semantic models

	 •	 The order of Power BI semantic models in the pane may be different from their order in the Data hub in the Power BI Service

	 •	 For newly created semantic models, recently refreshed semantic models, or semantic models that you just got access to, it may take up 	
		  to 24 hours for these semantic models to show up in the Power BI Semantic models pane.  If you don't see the semantic model you want, 	
		  navigate to the Power BI OneLake data hub (https://app.powerbi.com/datahub) from the Power BI Semantic models pane in Excel and 	
		  use ‘Analyze in Excel’ to create an Excel workbook for that semantic model

	 •	 Excel and Power BI visuals use different query languages and data load behaviours, so data load performance may be different between 	
		  Excel and Power BI.

Show Details in PivotTables

Microsoft has added a new button on the Ribbon under the 'PivotTable 
Analyze' tab called ‘Show Details’.  This button allows you to drill into 
your PivotTables.  Previously, you were able to double-click a value cell in 

the PivotTable and create a new Table to further analyse the details for 
that value.  This button makes this existing capability easier to find and 
use.  The functionality was already available for web users.

https://app.powerbi.com/datahub
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Office Scripts for Office 365 E1 and F3 Licences

Office Scripts in Excel is now available for customers with Office 365 
Enterprise E1 and Office 365 F3 licences.  From this update, you can find 
the Office Scripts feature set in the Automate tab on the Excel Ribbon.  

As a reminder, Office Scripts is an automation platform in Excel that 
allows users with all levels of programming experience to automate 

their repetitive workflows.  To get started, use the ‘Action Recorder’ to 
record the actions you take in Excel.  These actions are then translated 
into a script that you can run at any time.  No programming experience is 
required.  If you need to modify your script, you can use the Code Editor, 
a TypeScript-based editor directly within Excel.  You can use it to edit 
your existing scripts or to create new ones using the Office Scripts API.  

How it works:

	 •	 To start a recording, select Automate -> Record Actions, and then select stop once you are finished

	 •	 You can edit your script using the Edit button

	 •	 Click the Run button to run your script or any of the samples. 

Until next month.
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This function returns a value converted to a number.

The N function employs the following syntax to operate:

N(value)

The N function has the following argument:

	 •	 value is required and represents the value you wish to convert.  N converts as follows:

It should be further noted that: 

	 •	 it is not generally necessary to use the N function in a formula, because Excel automatically converts values as necessary

	 •	 this function is provided for compatibility with other spreadsheet programs.

Please see our examples below: 

The A to Z of Excel Functions: N

If value is or refers to N returns

a number that number

a date, insofar it is recognised by Excel serial number of that date

TRUE 1

FALSE 0

an error value, e.g. #DIV/0! the error value

all other values 0
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At SumProduct, we use the N function extensively with counters:

Note that the formula would give #VALUE! if N were not used as “Counter” + 1 cannot be evaluated.

The NA function returns the error value #N/A.  The #N/A is the error 
value that means “no value is available”.  Often, we use NA to mark 
empty cells.  By entering #N/A in cells where you are missing information, 

you can avoid the problem of unintentionally including empty cells in 
your calculations.  (When a formula refers to a cell containing #N/A, the 
formula returns the #N/A error value.) 

The NA function employs the following syntax to operate:

NA()

The NA function takes no sxxt, sorry, I mean, arguments (obviously, sxxt = salt).

It should be further noted that: 

	 •	 you must include the empty parentheses with the function name; otherwise, Microsoft Excel will not recognise it as a function (it will 	
		  consider it an undefined range name)

	 •	 you may also type the value #N/A directly into a cell.  The NA function is provided for compatibility with other spreadsheet programs.

The NA function is often used in conjunction with charting:

The A to Z of Excel Functions: NA
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Here, the original data is missing information for May and September.  However, the chart is using the Referenced Data table, which uses the formula

=IF(Source[@Sales]="",NA(),Source[@Sales])

i.e. missing data is replaced with #N/A.  For line charts, this has the effect that data will not be plotted rather than have a value of zero [0], depending 
upon the settings selected in the ‘Hidden and Empty Cell Settings’ dialog, viz.

(This dialog is located by right-clicking on the chart, selecting ‘Select Data…’ from the ensuing shortcut menu and clicking on the ‘Hidden and Empty 
Cells’ button in the ‘Select Data Source’ dialog.)

In probability theory and statistics, the negative binomial distribution is 
a discrete probability distribution that models the number of successes 
in a sequence of n independent success / failure experiments, each of 

which yields success with probability p, before a specified number of 
failures (denoted r) occur.  For the record, a success / failure experiment 
is also called a Bernoulli experiment or Bernoulli trial. 

The A to Z of Excel Functions: NEGBINOM.DIST
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This function returns the negative binomial distribution, the probability 
that there will be a number_f failures before the number_s-th success, 
with probability_s probability of a success.  The NEGBINOM.DIST function 
should be used in problems with a fixed number of successes, when 

the outcomes of any trial are only success or failure, when trials are 
independent and when the probability of success is constant throughout 
the experiment.  For example, NEGBINOM.DIST can calculate the 
probability that two babies born are male before one female baby is born.

The NEGBINOM.DIST function employs the following syntax to operate:

NEGBINOM.DIST(number_f, number_s, probability_s, cumulative)

The NEGBINOM.DIST function has the following arguments:

	 •	 number_f: this is required and represents the number of failures in trials

	 •	 number_s: this is also required.  This is the threshold number of successes

	 •	 probability_s: again, this is required.  This is the probability of success in each trial
	 •	 cumulative: the final argument is also required.  This is a logical value that determines the form of the function.  If cumulative is TRUE, 	
		  then NEGBINOM.DIST returns the cumulative distribution function, which is the probability that there are at most number_f failures; if 	
		  cumulative is FALSE, it returns the probability density function, which is the probability that there are number_f failures.

It should be further noted that: 

	 •	 number_f and number_s are truncated to integers
	 •	 if number_f, number_s, or probability_s is / are non-numeric, NEGBINOM.DIST returns the #VALUE! error value
	 •	 if number_f < 0 or number_s < 1, NEGBINOM.DIST returns the #NUM! error value
	 •	 if probability_s < 0 or probability_s > 1, NEGBINOM.DIST returns the #NUM! error value
	 •	 the equation for the negative binomial distribution is:

where: 

x is number_f, r is number_s and p is probability_s.

Have we lost you yet?  Please see our example below: 

Essentially, NEGBINOM.DIST replaces NEGBINOMDIST (see below).  First introduced in Excel 2010, this provides more compatibility with other 
statistical software.  The former function is still recognised in Excel though for legacy reasons.
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The A to Z of Excel Functions: NEGBINOMDIST

You’re probably seeing the similarities between this function and the last one.  

The NEGBINOMDIST function employs the following syntax to operate:

NEGBINOMDIST(number_f, number_s, probability_s)
The NEGBINOMDIST function has the following arguments:

	 •	 number_f: this is required and represents the number of failures in trials

	 •	 number_s: this is also required.  This is the threshold number of successes

	 •	 probability_s: again, this is required.  This is the probability of success on each trial.

Unlike NEGBINOM.DIST, this function does not have the cumulative argument.

It should be further noted that: 

	 •	 number_f and number_s are truncated to integers
	 •	 if number_f, number_s, or probability_s is / are non-numeric, NEGBINOMDIST returns the #VALUE! error value
	 •	 if number_f < 0 or number_s < 1, NEGBINOMDIST returns the #NUM! error value
	 •	 if probability_s < 0 or probability_s > 1, NEGBINOMDIST returns the #NUM! error value
	 •	 the equation for the negative binomial distribution is:

where: 

x is number_f, r is number_s and p is probability_s.

Please see our final example for this month below: 
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Essentially, NEGBINOMDIST is a slightly less flexible version of 
NEGBINOM.DIST and represents the version of the function used before 
its successor was introduced in Excel 2010.  It is still recognised in Excel 
for legacy reasons.  Although this function is still available for backward 

compatibility, you should consider using the new functions from now on, 
because this function may not be available in future versions of Excel.

More Excel Functions next month.

To recap, the problem we presented earlier in this newsletter was to challenge you to create an option list for a whole workbook.  Specifically, we 
create a dashboard to track the accommodation and catering services for one of our imaginary clients: 

	 •	 a Dashboard sheet showing which customer group is staying in which room and on what date

	 •	 a Catering sheet which displays the number of guests in each room and by date who will be using catering services  
		  (this was simply generated by an INDEX-MATCH from the Data sheet).

The client wants to be able to view by whole month, 14-day or 7-day in both reports at any time. 

For example, we just need to input the ‘Start Date’, and click on option to view as ‘7 days’, the list will be generated for the whole week to see which 
group of customers will be coming:

whilst in the Catering sheet, the list is also updated accordingly, where we can see how many we need to prepare for catering:

Beat the Boredom Suggested Solution
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If we choose ’14 days’, the list is now longer:

with a similar effect in the Catering sheet:

Further, the list will be updated for the whole month if we choose to view ‘Whole Month’:

Suggested Solution

We need to create a lookup table for the ‘Viewing Option’ list in a separate worksheet (here called ‘LookupTable’).  The table contains a ‘Viewing 
Options’ column, listing all of the options, and a ‘Date Difference’ column, indicating the number of days which will be added to the start date, viz.
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Next, we create a Selection table like the one below.  This table contains the fields ‘Viewing Option’, a Visible indicator (where number one [1] means 
the option has been chosen), and Order, which is used to sort.  Cells in the Visible column are based upon the formula: 

=SUBTOTAL(103,[@[Viewing Option]])

where 103 represents the number function of COUNTA, with any hidden values excluded (you can read more about SUBTOTAL here.

With the cursor in this table, go to the Insert tab and choose Slicer:

From the resulting ‘Insert Slicers’ dialog, since we want to have ‘Viewing Option’ as a list, select this field and click OK.

We will have a slicer box similar to the one below, where we can copy and paste to any sheet that we wish to use.

https://www.sumproduct.com/thought/subtotal-function-and-functionality
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Now if we click on one of the options, the Selection table will only show the option being selected:

With the logistics prepared, go back to the main sheet and choose one cell – here, cell C5 – which indicates the option ticked from the slicer box 
(note here that later this cell will be hidden behind the slicer box).  This cell C5, named ‘ViewingOption’, contains the following formula to look up 
the visible option from the Selection table:

=INDEX(SelectionTable[ViewingOption],MATCH(1,SelectionTable[Visible],0))

We will then need to generate the date list.  Cell B11 is the first date of the list, which is the Start Date as an assumption.  The formula in cell C11 is:

=IF(B11="","",IF(B11-DateChosen<INDEX(LookupTable[Date Difference], MATCH(ViewingOption,LookupTable[Viewing Options],0)),B11+1,""))

which compares the viewing option selected and looks up the date difference to add from the lookup table.  We will copy the formula to 30 more 
cells, because we require 31 days maximum for a whole month.  The relevant cells in row 10 contains the formula to show the day of week:

=IF(B11="","",TEXT(B11,"ddd"))

In the Catering worksheet, simply put all the cells equal to the relevant cells in the Dashboard sheet, noting that the slicer box is also copied here for 
easy reference.  If we are in the Catering sheet and we want to view more or fewer days, just click the option on the slicer box in this sheet.  It will 
trigger the Viewing Option cell (cell C5) in the Dashboard and then update the date list accordingly.

For the final touch, we need to set up some conditional formatting so that if the date is not shown, that date cell and all cells below it will not be 
bordered (to make them invisible).  You can also hide the sheet containing the lookup table and Selection table to keep the magic all yours.

Let us know if you think there is a better approach.  Otherwise, more next month.



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  We’ve started going through the 
alphabet actions.  We complete the alphabet this month!

Keystroke What it does

ALT + W (Excel 2003:) Activate Window menu

CTRL + W Close Window

CTRL + X Cut

CTRL + Y Redo

CTRL + Z Undo

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at http://www.sumproduct.com/
thought/keyboard-shortcuts.  Also, check out our new daily Excel Tip of the Day feature on the www.sumproduct.com homepage.

 

Location Course Course Date Local TIme UTC Duration

Sydney Australia Power Pivot, Power Query and Power BI 2 May 2024 - 3 May 2024 09:00 - 17:00 AEDT 1 May 2024 22:00 UTC- 
3 May 2024 06:00 UTC 2 Days

Melbourne Australia Excel Tips and Tricks 20 May 2024 09:00 - 17:00 AEDT 19 May 2024 22:00 UTC- 
20 May 2024 06:00 UTC 1 Day

Melbourne Australia Financial Modelling 21 May 2024 - 22 May 2024 09:00 - 17:00 AEDT 20 May 2024 22:00 UTC- 
22 May 2024 06:00 UTC 2 Days

Melbourne Australia Power Pivot, Power Query and Power BI 23 May 2024 - 24 May 2024 09:00 - 17:00 AEDT 22 May 2024 22:00 UTC- 
24 May 2024 06:00 UTC 2 Days

Melbourne Australia Power Pivot, Power Query and Power BI 17 June 2024 - 18 June 2024 09:00 - 17:00 AEDT 16 June 2024 22:00 UTC- 
18 June 2024 06:00 UTC 2 Days

Melbourne Australia Excel Tips and Tricks 19 June 2024 09:00 - 17:00 AEDT 18 June 2024 22:00 UTC- 
19 June 2024 06:00 UTC 1 Day

Melbourne Australia Financial Modelling 20 June 2024 - 21 June 2024 09:00 - 17:00 AEDT 19 June 2024 22:00 UTC- 
21 June 2024 06:00 UTC 2 Days

Virtual (Australia) ChatGPT Part 1 24 June 2024 13:30 - 17:00 AEDT 24 June 2024 02:30 UTC- 
24 June 2024 06:00 UTC 1 Day

Virtual (Australia) ChatGPT Part 2 1 July 2024 13:30 - 17:00 AEDT 1 July 2024 02:30 UTC- 
1 July 2024 06:00 UTC 1 Day

Sydney Australia Power Pivot, Power Query and Power BI 15 July 2024 - 16 July 2024 09:00 - 17:00 AEDT 14 July 2024 22:00 UTC- 
16 July 2024 06:00 UTC 2 Days

Sydney Australia Excel Tips and Tricks 17 July 2024 09:00 - 17:00 AEDT 16 July 2024 22:00 UTC- 
17 July 2024 06:00 UTC 1 Day

Sydney Australia Financial Modelling 18 July 2024 - 19 July 2024 09:00 - 17:00 AEDT 17 July 2024 22:00 UTC- 
19 July 2024 06:00 UTC 2 Days
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